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KATA PENGANTAR

Dengan mengucapkan rasa syukut kepada Tuhan YME, penyusun
berterimakasih dapat menyusun modul praktikum Geomodel ini. Modul ini merupakan
pegangan praktikum bagi mahasiswa Teknik Geologi S1 pada semester 6, dengan bobot
1 sks.

Modul ini berisi beberapa materi yang diajarkan pada kegiatan praktikum
Geomodel, yang diharapkan dapat menjadi arahan bagi mahasiswa untuk mengenal
berbagai program geologi yang menunjang tugas akhir berupa pemetaan geologi.
Beberapa hal yang diajarkan dalam modul ini antara lain tentang global positioning
system (GPS), program Mapinfo serta Corel Draw.

Dengan selesainya bahan ajar ini, penulis mengucapkan banyak terimakasih kepada:
1. Ketua STTNAS Yogyakarta.
2. Ketua Jurusan Teknik Geologi, STTNAS Yogyakarta beserta staf.
3. Segenap asisten yang telah berpartisipasi dalam pembuatan modul dan membantu
pelaksanaan praktikum, yaitu Kholilur , llofi, Farida serta Anggi.
Akhir kata, semoga modul ini bermanfaat dan dapat memandu praktikan untuk
melaksanakan tugas-tugas yang dibebankan pada kegiatan praktikum.

Yogyakarta, April 2010.
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LR - FUNGSI TOMBOL GPS GARMIN (60 CSx):

1. Tombol On /Off : -Tekan dan tahan tombol untuk mematikan / menghidupkan GPS.
- Tekan satu kali untuk mengatur pencahayaan layar.
2. Tombol Zoom In : -Tombol ini berfungsi pada halaman peta (map page) intuk memperbesar

! Zoom Out / memperkecil skala pada layar.
3. Tombol Find : -Berfungsi untuk mencari suatu titik yang telah diplot sebelumnya.
4. Tombol Mark : ~ Berfungsi menyimpan (plotting) data titik yang telah didatangi.
5. Tombol Page : = Berfungsi untuk menuju ke halaman (page) GPS selanjutnya.
6. Tombol Quit . -Berfungsi untuk ke luar dari halaman atan kembali ke halaman (page)
GPS sebelumnya.
7. Tombol Rocker  : -Berfungsi untuk memilih menu atau menggerakkan kursor pada tampilan
di layar.
8. Tombol Menu : -Tekan satu kali berfungsi untuk menampilkan pilihan menu masing-
. masing halaman (page).
> -Tekan dua kali berfungsi untuk menampilkan halaman menu utama
(main menu page).
‘1 - 9. Tombol Enter . - Berfungsi untuk memilih menu / sub-menu pada layar.

-Pada halaman peta gerakkan kursor kemudian enter untuk menandai
(plot) titik yang akan di tuju sesuai dengan koordinat yang diketahui
sebelumnya.

HALAMAN GPS GARMIN (60 CSx):
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Semua informasi yang dibutuhkan untuk mengoperasikan Garmin 60CSx dapat ditemukan
dalam halaman standar, halaman-halaman ini antara lain Satellite, Trip Computer, Map, Compass,
Altimeter dan Main Menu. uttuk memilih halaman-halaman tersebut tekan tombol PAGE sampai
menemukan halaman yang di inginkan.

L. Satellite Page: menampilkan jumlah satelit yang diterima dalam bentuk diagram batang dan sky
plot, posisi atan koordinat geografi (lintang dan bujur) serta ketelitian koordinat.

2. Trip Computer Page: wenampilkan informasi data untuk navigasi seperti kecepatan, arah jarak,
waktu, posisi, ketinggian dan lain-lain.

3. Map Page: menampilkan peta dan informasi navigasi sesuai kebutuhan pengguna.

4. Campass Page: menampilkan informasi navigasi dalam bentuk tampilan kompas.

5. Altimeter Page: Pada menu altimeter, terdapat 2 fungsi, yaitu untuk mengetahui elevasi (altimeter),
dan untuk mengetahui tekanan udara (barometer).

6. Main Menu: halaman utama GPS yang berisi ikon menu antara lain altimeter, track, route, setup
serta beberapa program bantu seperti kalkulator, kalender, stopwatch, games dan lain-lain,

OPERASI STANDAR GPS GARMIN (60 CSx):
1. Pengaturan Unit
Pengaturan unit yang dimaksud adalah mengatur parameter satuan termasuk proyeksi
{prajection) pada GPS sehingga sesuai dengan standar satuan data yang dipergunakan, langkah
pengaturan unit:
e Pilih main menu pada halaman GPS (dapat dengan dua kali klik tombol menu).
e Pilih ikon sefup menggunakan tombel rocker kemudian tekan tombol enter.
o Pilih ikon units menggunakan tombol rocker kemudian tekan tombol enter.
o Pindahkan kursor pada position format menggunakan tombol rocker kemudian enter;
- Pilih format hddd'mm’ss.s” untuk proyeksi koordinat geografi (satuan derajat, menit, detik).
- Pilih format UTM UPS untuk proyeksi koordinat UTM (satuan meter).
e Pindahkan kursor pada map datum pilih format WGS 84.
e Pindahkan kursor pada elevation pilih format Meters (m/sec).*
e Pindahkan kursor pada pressure pilih format Milibars.*
o Setelah selesai tekan tombol quit.
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2. Menandai Lokasi (marking / plotting waypoints)
A. Menandai lokasi yang belum didatangi
Adalah menandai lokasi yang belum didatamgi tetapi telah diketahni koordinat
lokasinya, cara ini dilakukan apabila pengguna memiliki peta topografi dengan proyeksi
koordinat yang telah disesuaikan dengan proycksi GPS, langkah yang dilakukan:
o Pada halaman peta (map page) gerakkan kursor dengan menckan tombol rocker
kemudian tekan tombel enter.
¢ Muncul dialog, kemudian pilih yes.
¢ Ubah simbol dan nama sesuai dengan yang dikehendaki.
e Ubah angka koordinat pada kolom location dengan angka koordinat yang telah diketahui.
e Setelah selesai tckan tombol guit.
B. Menandai lokasi yang telah didatangi
Adalah menandai lokasi dimana pengguna GPS berada, langkah vang dilakukan:
e Tekan tombol mark pada GPS, pada GPS yang tidak memiliki tombol mark bisa dengan
‘V‘ t menekan tombol enter kemudian tahan.
» Ubah simbol dan nama sesuai dengan yang dikehendaki.
» Setelah selesai pilih OK kemudian tekan tombol enter.

Waypoint. Hark yn!
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3. Memuat Trek (fracking)
ol Trek adalah lintasan yang dilewati yang akan direkam secara otomatis oleh GPS
B sementara alat ini dinyalakan, langkah mengaktifkan trek:
» Pilih main menu pada halaman GPS (dapat dengan dua kali klik tombol menu).
o Pilih ikon fracks menggunakan tombol rocker kemudian tekan tombol enter.

o Pilih clear (apabila percentage of memory in use belum 0%) kemudian tekan tombol enter,
kemudian akan muncul dialog, pilih OK.

e Untuk membuat trek baru adalah dengan memilih ON kemudian tekan tombol enter.
o Jika trek selesai maka simpan dengan memilih SAVE kemudian tekan tombol enter.
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Ré;glgigradglahprgses pemberian koormnatpadafngml;arﬁqter (ﬁle Jcms]PG: ISI':I”G,HG[F,
dll.) sehingga gambar tersebut memiliki koordinat yang sesuai dengan koordinat di permukaan bumi.
Gambar raster yang telah diregister ini sclanjutnya untuk dapat dijiplak (digitize) objek-objek yang ada
di dalamnya (misal: kontur, sungai, toponomi, dll.) dengan menggunkan aplikasi berbasis SIG.

1. Register pada aplikasi Global Mapper
o Buka aplikasi Global Mapper, klik file > open data file (Ctrl+0).
e Pilih gambar raster yang akan diregister, akan muncul dialog, pilih manually rectify image,

klik OK.
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e Buat 4 titik masing-masing pada pojok gambar sebagai titik ikat koordinat sesuai pambar
raster (peta) yang akan diregister, kemudian masukkan koordinat X, Y yang ada pada masing-
masing pojok peta.

o Sebelum memasukkan nominal koordinat pastikan proyeksi Global Mapper telah disesuaikan
dengan proyeksi peta (Geogrphic manpun UTM) dengan datum WGS 84, Hal ini bisa
dilakukan dengan klik select projection kemudian sesnaikan kolom projection dan datum,
kemudian klik OK. '

e Selanjutnya isi nominal kolom ground control point dengan nominal yang sesuai dengan
koordinat titik ikat, Untuk peta dengan koordinat geografi (derajat, menit, detik) cukup
pisahkan angka koordinat¢ dengan spasi.
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e Jlka nomma] telah dimasukkan klik add point to fist klik OK. Masukkan hingga 4 titik ikat

kemudian klik OK.
¢ Kemudian pilih pada tab File > Export raster / image format, pilih GeoTIFF kcmudian OK.
¢ Akan muncul dialog, kemudian klik OK, kemudian seve dengan nama “PETA_Nama
Rk - Mahasiswa_ NIM”.

2. Register pada aplikasi Mapinfo
»  Buka aplikasi Mapinfo, klik file > open (Ctrl+0).
o Pilih gambar raster yang akan diregister, jika file yang dimaksud tidak ditemukan maka ubah
kolom files of fype menjadi raster image kemudian pilih file yang akan dimaksud, klik Open.
KemudJan akan muncul dzdlog, pilih register.
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e  Scsuaikan proyeksi pada kolom permtah dengan klik projection tool.
s Jika akan menggunakan proyeksi utm maka tinggal memilih category universal transverse
mercator zone 49 southern hemisphere (WGS84),
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® Jika akan menggunakan proyeksi geographic dengan satuan degree-minute-second ( ° ¢ “ ),
maka harus dikonfersi ke satuan decimal degree. Caranya dengan asumsi bahwa 1° adalah 60’
dan 1° adalah 60”, kemudian diaplikasikan ke dalam desimal.

o Untuk mempermudah pemasangan titik ikat tekan tombol “C” pada keyboard untuk

memuncu]kan string.
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e Klik titik yang merupakan pertemuan antara nominal koordinat x dan y maka akan muncul
kolom perintah “add control point’

e Isi kolom “map x” dengan nominal x dan “map y” dengan nominal v pada peta raster. Jika
telah terisi koordinatnya kemudaian klik add untuk membuat titik ikat yang lain

« Buat 4 titik ikat (idealnya pada masing-masing bagian pojok peta).

e Jikatelah terinput 4 titik ikat, maka perhatikan eror pada kolom perintah, usahakan total cror

adalah 0
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e Selaraskan nominal x & y dengan mengubah nominal pada kolom image x dan image y.
e Jika total eror telah menjadi 0 kemudian klik QK.
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MEMBUAT Z4BLE PADA MAPINFO

Table adalah komponen file dasar pada mapinfo (Jems file tab) Dimana komponen ini terdiri
atas titik (point), garis (polyline, arc), dan luasan (polygon, rectangle, ellipse). Mudahnya, table
dimisalkan satu lembar kalkir yang setiap lembar digambar dengan titik atau garis atau luasan, yang
kemudian setiap kalkir ( (able ) ini kita susun menjadi satu gambar peta utuh. Cara pembuatan Table:

® Buka aplikasi Mapinfo, klik tab File > New Table (Ctrl+N).

¢ Pada “kolom perintah” isi name pada field information dengan “keterangan”™ (scsuai keperluan).
Field information ini nantinya akan menjadi lebel pada masing-masing objek setiap table.

® Ubah &pe pada field information menjadi character. Width pada field information mempengaruhi
banyaknya karakter yang dapat dimasukkan sebagai keterangan pada masing-masing objek.



e Atur proyekst dengan klik projection pada “kolom perintah”, akan tampil seperti di bawah ini:
T " 2 {

o Ubah category menjadi universal transverse mercator (WGS84), kemudian pilih category
members menjadi utm zone 49 southern hemisphere.

o Pemilihan proyeksi peta dapat menyesuaikan keperluan, diharapkan untuk teliti dalam
pengaturan proyeksi setiap fable.

o Setelah memilih creare pada “kolom perintah™ maka akan muncul seperti ini:

e Klik create new folder dan namakan dengan “latihan™.
e Setelab folder “latihan” jadi kemudian klik open. Tsi file name dengan “BORDER Nama -
Mahasiswa_NIM”, kemudian save. '
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e Kemudian akan mucul tampilan seperti ini:
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e Nyalakan tool “editable” pada table “border™.

e Pilih fool “rectangle” untuk scgera membuat objek luasan (daerah kaplingan). Luasan dibuat

sembarang terlebih dabulu.
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o Klik 2 kali rectangle vang telah dibuat, dan muncul tampilan seperti ini:
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o Isi koordinat X1-X2 dan Y1-Y2 dengan koordmat kapling masing-masing,.

e Klik OK, maka objek yang telah dibuat akan menghilang. Untuk menampilkan rectangle tersebut

kembali klik kanan table “border” pada layer contrel kemudian pilih view entire layer.

e Jika objek masih belum terlihat kemudian klik pada tab discover > map window > zoom to extents

af selected object.

e Cara memberikan label pada objek: gunakan info tool, klik pada objek rectangle kemmudian akan
muncul seperti tampilan di bawah:

ﬁsr&mmq—,mml&nmun

e Isi informasi dengan (mama mahasiswa / NIM) pada kolom, jika telah selesai klik close pada

“kolom perintah”.

e Untuk menampilkan label yang telah dibuat cukup aktifkan feel “automatic labels” pada layer

conltrol,
o Save (Ctrl+S) 1able.
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Digitize adalah proses “menjiplak” objek pada gambar raster untuk menjadi file tab (ible),
masing-masing objek dibuat dalam table yang berbeda. Yang dimaksud objek di sini dapat berupa titik
(contoh: titik toponomi, elevasi indeks, dil.), garis (contoh: garis kontur, pola pengaliran, dll.), dan
luasan (contoh: daerah adminstrasi, batas litologi, dil.). Tata cara digitize:
@ Pada aplikasi Mapinfo, klik tab File > Open (Ctrl+O).
e Pilih file raster yang telah diregister (. TIFF). Ubah kolom files of type menjadi raster image
kemudian pilih file yang akan dimaksud, klik Open.
» Jika table border tampak menutupi gambar raster maka ubah siy/e-nya dengan cara klik dua kali
pada objek “border”, tapi sebelumnya harap dinyalakan terlebih dahulu editable tool pada layer
control
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o Kemudian ubah style dengan memilih “N” (none) pada fill patiern.
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e Langkah selanjutnya adalah mulai membuat /fable baru ( file > new table / ctri+n). Hilangkan
centang pada open new mapper dan centang pada add fo current mapper kemudian klik create,

e = Fi 3

e Karena field information nantinya akan menjadi label/keterangan, dan yang akan di-digitize adalah
kontur, maka field information diisi dengan elevasi.

e Saparl. BN .
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e Kemudian pilih create dan save dengan nama “kontur_digit”.
10



9

o Maka kemudian akan muncul fable “kontur digit” pada layer control. Nyalakan editable tool,
kemudian table siap untuk digambar dengan objek garis konfur.
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o Kemudian beri label pada masing-masing objek dengan angka ketingggian (elevasi), save table.

Clipping adalah metode clip / cra p / memotong beberapa bagian dari database file mapinfo
dengan tujuan dapat disajikan sesuai kebutuhan masing-masing pengguna. Objek database yang akan
dipotong adalah kontur, sungai, jalan dan batas administrasi (sesuai keperluan peta topografi),
sementara vang berperan sebagai “pemotong” adalah file “border” yang telah sesuai dengan luasan

daerah kapling. Tata cara clipping:

e Klik tab File > Open (Ctr1+0). Pilih filc database .tab yang akan kita clip.
o Jika iable lain dianggap mengganggu, untuk sementara tutup terlebih dahulu dengan
menghilangkan centang pada visible, hanya fable “border” dan database saja yang ada di layar peta.

o Langkah berikutnya adalah buat fable “kontur” menjadi editable.
o Setelah table “kontur” pada kondisi editable kemudian select salah satm objek garis pada table
tersebut, berikutnya klik kanan dan pilih perintah select all from selection layer, maka seluroh

obijck garis pada table “kontur” akan ter-select.

11
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¢ Untuk dapat di-cfip, suatu objek harus dijadikan “ferget”, caranya adalah klik kanan, kemudian
pilih edit ohjects kemudian set target.

e Setelah fable “kontur” menjadi “targes” kemudian select objek luasan pada tabfe “border” (vang
akan menjadi pemotong).

e Jika dirasa objek “border” sulit untuk di-se/ect, maka pindabkan table “border” pada /ayer control
yang semula posisinya dibawah zable “kontur” dengan cara klik-tahan-geser ke bagian atas 7able
“kontur”.

e Langkah berikutnya adalah *

: EA e - . R
S e I e

cmotong kontur di luar kapling”, caranya adalah klik kanan > edit

objects > erase outside > ok

ottt T B
@ vy @ &

e Kemudian simpan fable “kontur yang terpotong” dengan cara klik pada tab file > save copy as,
simpan dengan nama “Kontur Nama Mahasiswa NIM”.
¢ Berikumya adalah tutup fable “kontur” dengan klik pada tab file > close table pilih fable “kontur”,
ketika ada permintaan unluk save pilih discard. *
e Kemudian buka kembali table “Kontur Nama Mahasiswa NIM”,
*Karena table yang dipotong merupakan database yang bisa diganakan seterusnya, jika telah terpotong

harap selals menyimpan copy dari tahle tersebut, kemudian jika menutup table yang merupakan
database harap memilih discard untuk menjaga table database tetap utuh.
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?Kﬁ NVERSI KOORDINAT PADA MAPINFO |

 Pada Eroyekﬂ geogmﬁ pcmmsalahan vang biasa muncul adalah Kkonfersi dari satuan “Dér{]&t-
menit-detik” ke satuan “Derajat-desimal”, langkah efisien jika terdapat bamyak data yang harus
dikonversi adalah:
® Buat Tabulasi data pada aplikasi Ms. Excel seperti gambar berikut:

s Nilai dari satnan “derajat-menit-detik” pada penulisan dipisahkan dengan spasi. Kolom “X” dan
“y” dibuat kosong terlebih dahulu. Simpan data tersebut (Ctrl+S) dengan format Ms. Excel 97-
2003 worksheet (.xls) dengan nama “Konversi Nama Mahasiswa_NIM”.

e Kemudian pada aplikasi Mapinfo buka (Ctrl+0) file .xIs yang telah dibuat.

e Pilih files of type menjadi microsoft excel, nyalakan centang pada mapinfo places juga pada create

 copy in mapinfo format for read/write.

e Kemudian akan muncul kolom perintah dengan judul excel information, centang pada use row
above selected range for column tifles, klik OK.

o Kemudian akan muncul dialog seperti berikut:

Type field “Longitude” adalah Character.

Type field “Latitude” adalah Character.

Type field “X” adalah Decimal dengan nominal Width
sebesar 10 dan Decimals scbesar 6.

Type field *Y” adalah Decimal dengan nominal Width
sebesar 10 dan Decimals sebesar 6.

Setelah sesnai klik OK.

e
Ehafactai[?ﬂ

‘ @g& o E&m i PR R RN LR

,gf!!"{":‘r"

X Iy
B 192 45 50 EXED CO0000) 3030000
i Olipz a2 45 555 o] 0%
| Ojnz s 7t 10 CODUET Dol
i sz 3 5 555 00 20 puOp
iEI 741 45 EXE L0000 36000
i

o Langkah selanjutnya pastikan tool “Degree Converter” telah terpasang dengan cara pada tab klik
Tools > Tool Manager maka akan muncul tampilan sebagai berikut:
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g
Toot Manager
p
l Tools
| [ Create Line By Length
| DBMS Catalog
{ DBMS Courd Rowes in Table
I | Degree Converter
; Lielete Uuplicates
' | Disperse Points
| | Distance Calculator
| Easploader
| Encom Discover

& e

o Beri tanda centang pada rool Degree Converter, Klik OK.
» Kemudian klik pada tab Tools > Converter > Convert Column to Decimal Degrees, maka akan
muncul dmlog sebagm berikut:

Isi kolom DMS Separator dengan spasi.

e | Jikn Kolom Get DegMinSec value from adalah
| forice ] i Longitude maka pada kolom Store result in dipilih
il DHS eparsior | “Y?,

- Jika Kolom Get Deg.Min.Sec value from adalah
Latitude maka pada kolom Steore result in dipilih “Y™.

- Setelah sesuai klik OK.

- Lakukan konversi pada kolom Longitude dan Latitude.

3112 45 50

417 42 a5 -6 59 &5

3112 36 75 -7 91 00 112.620833
L3112 39 55 -f 59 00

I:i 112 41 45 -7 06 00

e Simpan data tabulasi (Ctrl+S)

-PL{?TI‘EVG PADA MAPINFO :

 Plotting adalah proses penentuan fitik lokasi. Karena angka koordinat input dan ouiput harus
sesuali maka pengaturan proyeksi gps harus telah tersinkronisasi demgan proyeksi peta yang akan
dibuat. Jika penentuan titiknya ketika pengguna berada di lapangan, maka pembacaan koordinat pada
¢ps dan penentuan dalam pcta topoprafi adalah dengan menarik gans harus angka koordinat x & y.
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Proses plotting menggunakan mapinfo:

Akan tetapi jika berhubungan dengan banyak data lokasi yang harus disajikan, maka harus
dilakukan tabulasi data terlebih dahulu (dapat menggunakan ms. Excel). Untuk mempermudah
inputting data dan keseragaman harap ketika tabulasi data menggunakan format seperti yang ada pada
contoh gambar dibawah:

3225600
9225300
Erreliny
9222500)
S222704]
2215200
SEI500

m;\'ruﬁnwws FORMAS! NGRATONG
DSC-002 JBATUPhSI'R FORMASE NGRAYONG
DSC-003 {BATUGAMPING FORMASI NGRAYONG
DSC-004 [BATULEMPUNG FORMASI BULY
D005 BATULANAL FORMASI PASONGSONGAN
DSC-008 BATULANAL FORMASI PASONGSONGAN
D5C-007 BATUGAMPING FORMASI MADURA
DSC-008 BATUGAMPING FORMASE MABURA

Jika menggunakan proyeksi koordinat UTM maka tabulasi data pengamatan menggunakan aplikasi
Ms. Excel dengan format seperti gambar di atas.

Jika menggunakan proyeksi koordinat geografi maka tambahkan kolom “Longitude-Latitude”
sementara kolom “X-Y dibuat kosong seperii pada BAGIAN VL

Setelah semua data di-input selanjutnya save dengan format Ms. Excel 97-2003 worksheet (xls)
dangan nama “POINT Nama Mahasiswa_ NIM”, kemudian tutup Ms. Excel.

Selanjutnya buka file tabulasi (.xls) tadi pada mapinfo (Ciri+0).

Pilih files of type menjadi microsoft excel, nyalakan centang pada mapinfo places juga pada create
copy in mapinfo format for read/wnte.

Fap o BEES

G PULING, . 38 tROW 5 JOE A Wa
Czasar: e
T
3
e
A DESE POAES
Al RALENG
L TR
AR e

MR N R N

=

R T &
- RN

T Laha . BT T "‘i 4"'-‘*'. e
§ |
wl { ,’ e
b= FILE M5, EROCL 1 ] | Brwdtingr DoghASD) =
el !f 1] toesita eamcs
PR ST 1 f | {. rrs m lvﬂ.iﬂ' i
| ..“II-“. -
} !’ H o st o
i H £ Sait ) |t
i (] et T P —

e | s -
| )‘_ﬁi“"’“’ St Eed T " _r{ e |
mﬁiwu .‘_‘ﬁ T H [

T T L R

J?m& FIRE j

!
].guml | e ﬁ—d-m'ﬁh! i I[

N e e e

e Kemudian akan muncul kolom perintah dengan judul excel information, centang pada use row
above sclected range for column titles, klik OK.
° Kemudlan aka.n muncul dialog seperti berikut:

P’ Decmal10.0]
|ELEVASI Decimay10.0}

|KODE_SAaMPEL Characted(E)
KODFE_FOTA Character{7}

“Fiediricmation
Nane  TITIE

_— i_ il gl 1-_}
Widh: 8

5:{ Foeld Fm-pemes '. B s

KETERANGEN  Chersclef0B |

(o) (o ) ] |

|
i

- Type field “TITTK™ adalah Character.

- Type field “X” adalah Decimal,

- Type field “Y” adalah Decimal.

- Type field *ELEVASI” adalah Integer,

- Type field “KODE_SAMPEL” adalah Character.

- Type field “KODE_FOTOQ? adalah Character.

- Type field “KETERANGAN" adalah Character.

- Untuk proyeksi geografi sesuaikan seperti pada
BAGIAN VI,

- Setelah semua terseting sesuai klik QK.
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_STRIKE IIP PLOTTIN G PADA MAPINFO

o Selanjutnya akan muncul tampilan seperti berikut:

T ot ] ®oce FoRlvETERANGE
L O5SCHH | BATIDANPINO FORMASIN SRAY:
loscor | EAT. msmm %mmn

i
1

B POLENG~— 54 1509 3 16036 War
] 1
J
i

Casmetic Lamer
| - emoroung
Aa

=
O
)¢
(=
S
i
o
=

e FLEE
e Jika menggunakan proyeksi knordmat geﬂgrafi sesualkan pengisian kolom seperu pada
BAGIAN VI, serta konversi koordinat terlebih dahulu,

e Selanjutnya pilih tab table > create pomts. Maka akan muncul:

0""‘_“"“.“ R 2 | - Pilih file “Point” (dari ms. Excel) pada
, Create Pointe fot Table | POINT_PGLENG : T § f perintah create points for table.
rg g ; [ Gmea | || - Atur model point dan besarammya pada

(| [ioecion  UITH Zone &5, Soutien Fiemiphese TWES 68 { Frogcion perintah using symbol.

—— i - Sesnaikan proycksi yang digunakan®,
E . -
| R - Pada perintah get coordinates from column
' Miuboyy the X Comtnates by — _ disesnaikan dengan X & Y.
| sty contninty 1 | - Kemudian klik OK.
*Selalu sesuaikan proycksi yang dipunakan,
karena nominal koordinat dengan proyeksi
vang berbeda tidak akan dapat terbaca.

| § Gorx Coordinatos from Colvae. (%

° Selan_;utnya close terlehlh dalmlu table “point™.
e Sciclah tertutup, buka lagi (CtrHO) table “point”, maka jadilah tampilan “point™ pada map
window mapinfo.

W i &
T AN
RPN, W93 d_ W

ot Lipe:

B TR RS

e Nyalakan icon lable pada layer control untuk memunculkan labelnya. Atur tampﬂan label pada
table point dengan klik 2 kali pada table tersebut, pilih lable display, pada lable with pilih
keterangan yang dikehendaki, sesuaikan juga tampilan label dengan merubah style-nya, klik OK.

Secara umum plottmg stnke-dipfkekarffoham ‘adalah sama dengan p(orzmg point, hanya
berbeda format tabulasi dan beberapa langkah tambahan. Buat file pada Ms. Excel dengan format
seperti berikut:

_l'.ﬂ_____ et ;i 5 e e & S O

K| X W ELEWAST STRIE oIP _ KODE KETERAMGAN
SPEVROL | 792000] wPwsEnn as 75 as 1|{STRIKE-ONE
SPLVROZ | 793000 9225600 HU 105 s0 1|STRIRE-DIF
SELVROI | 782200 5321300 60| s az 1iFOLIAS
SELVR 04 792500 922IGO0 L 35 20 ilFoLasT
SPLVE 05 792800| 9222900 B5, 110 15 1/ KEKAR |
SPLVROG | 793%00; $22270C 20 285 25| 2 KERAR i
SPLVR OT7 790700) 8218260 =] 260 12 I|STRIKF-TAR
SPLVR O | asam| 9@i900! o] 285 15| I|STRIKE-OW
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Ms.

Pada contoh gambar menggunakan proyeksi koordinat UTM, isi kolom “Kode” dengan angka
“1” (berfungsi sebagai kode strike-dip pada aplikasi mapinfa), kemudian simpan dengan file format

Excel 97-2003 Worksheet (.xIs) dengan nama “SD_Nama Mahasiswa_ NIM?”,

Jika

menggunakan proyeksi koordinat geografi maka tambahkan kolom “Longitude-Latitude” sementara
kolom “X-Y™ dibuat kosong seperti pada BAGIAN VL. Selanjutnya tutup aplikasi Ms. Excel dan buka
aplikasi Mapinfo:
e Buka hlc pada apl:kam Mapinfo (CtrHO).

K Covmend
4

. b F g

POINT_PORENG .54 1608 T N63T 6 W

Casres Lipar

® PONTSOLES %W

U FUIERG

¥ FRAME L]
¥ ADHA 3754 POIENS

H oo MNP

=z IR PRNT

o

mcr-

i

Lakin | Lavan

L COMTROINS STBELE 0L

TEED Toesn AR i\mmn
b oML T T
i g, - w—'. =

COHTUR AT &

. .:‘ ._. N .'I
¥ BCROER P : l
R B L PMEG »  Efmals
i & LT ) Shemact Eeoe: Tt Toks, =l Gt [
sy b e !
- o R R S EE
I # it Pl ) Cos i Hiinonafm et |

Suanctand Faie
e -

o Pilih files of fype menjadi microsoft excel, nyalakan centang pada mapinfo places juga pada create
copy in mapinfo format for read/write,
e Kemudian akan mmmcul kolom perintah dengan judul excel information, centang pada use row
above selected range for column titles. Klik OK.
¢ Kemudian akan muncul dlalog sebagai berikut:

Set Faid Prapert!es

52 | - Tvpe field “TITIK™ adalah character.

Fields

iELEVASI
ISTH!KE

'KETEFFANG#,N

Type

Dreximnai13.9]
Decimal{13.3]
Decmal{15,9]

__ Decinafiss) "

Cf:aracter] 3
Fietd Information :
Mame: KODE
Type: | Decimal M
Width: 13 Decimale: 3

BAGIAN VL.

L oK j‘écmtlt Hep |

A

e Maka akan muncul tampilan seperti berikut:

- Type ficld “X* adalah Integer.

- Type ficld “Y” adalah Integer.

Type field “ELEVASI” adalah Integer.

Type field “STRIKE” adalah Integer.

- Type field “DIP” adalah Integer.

| - Type field “KODE” adalah Integer.

“o1 |l - Type ficld “KETERANGAN” adalah character.
' - Untuk proyeksi geografi sesuaikan seperti pada

- Setelah semua telah sesuai klik QK.

e Jika menggunakan proyeksi koordmat gcograﬁ sesuaikan pengisian lmlom sepern pada

BAGIAN VI, serta konversi koordinat terlebih dabulu.
o Selanjutnya pilih tab table > create points, maka akan muncul:

Ly Cortrol ix Ix Iy Jerevas fsmwe . low _IKerE TkETeRaNGa |
TEYE 10 Olfseuimat 752 500 GO 3275 617 NS TE QAR 25 600 100 SIRKEDF
‘ ' = Ojsrivzo TE3.000 60600000 9,225 B0T (00000 1% 20000 100006903 STREE-DE.
— T ; 1 Olspua 762900 BGI00G! 9,224 300 08X R ? £ 0000 st
POINT_POLTNG,, 54 1609 3 1508 & ol Olisrvaes G0 10000060007 | FO_IASH
i e | Oliskuimrs ]

5 i | Oisruris ;

T e 3 ¢ Olsmmar fn e

o GRDRDIAG Eﬂ% S
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i Creare Paints

|| Creste Poisfor Table: [STAIKE DIE FOLENS.

usig Spmibok ‘;QJ

h Prajectioy T Zonie 43, Southem Hemisphere fES 24)

| Get Coolnates fiom Cohsmr: [

| Gt Coodinates fomCokeary. (¥

 bhultiply he X Coordinares byr 1

|

|

&

|

i

i

!i Muttiply the " Coordinates byr 1
E -+ Display rocrmumenc feids

F o Dvemite evizing pomts

e Selanjutnya close terlebih dahulu table “strike _dip”.

" = 1 - Pilih file “Strike Dip” (dari ms. Excel) pada
o 1! perintah ereate points for table.
{Z —FW; F - Atur model point dan besarannya pada
e || perintah using symbol
s, ] - Sesuaikan proyeksi yang digunakan*.
| - Pada perintah ger coordinates from column
| disesnaikan dengan X & Y.
| - Kemudian klik OK.
f *Selalu sesuaikan proyeksi vang digunakan,
i karena nominal koordinat dengan proyeksi
|

i

yang berbeda tidak akan dapat terbaca.

o Setelab tertutup, buka lagi table “strike dip”, maka jadilah tamupilan “point™ pada map window

mapinfo.

Untuk mempermudah proses data, matikan terlebih dabulu visible tabel selain “border” dan

“strike_dip” dengan menghilangkan centang pada bagian kiri masing-masing tabel.

Selanjutnya klik pada tab discover > structure symbols maka akan mucul dialog:

s o
PN s B

| STRIE_ DIP_POUENG... S 1600 1 1608

%

g
Do I

P s

s : [ P (%

T Mibm amatien caprel e selncisd il

kI TABEL

[ —————— 12 L

e Maka akan muncul dialog sebagai berikut:

Stiuctural Data Mapper

| SeuchmalMapping Topa

| L34 stuonral ymocie (modieg 11565) ._‘-,
. Speciy agmuth a2 Dip Divection
+ [ Speciy saimuth &3 Svee verg g hand e |

Colurnns For STRIKE_DIR_POLENG

Easting %
Nosthing s sstprs
Shike (GIREE
Dip Angh B
Stuchus Code  KODE

fafiedle

Symholdl ahal Style Opn

o M
Dorit diplay dp/alnge

|8 Dip/piung 03 Mapinla labels. § M’
Dip/pungz a5 it in cosmetic laye:

1 S iabets 8t O ervd 90

T

rule.,
- Pilih kolom Easting

e Selanjutnya atur tampilan foliasi dan k

ekar.

e Nyalakan centang pada process firom table kemudian pilih tabel “strike dip”. Klik OK.

- Pilih type USA structural symbol.
- Centang specify azimuth as strike using right hand

pada “X” dan Northing pada “Y”.

/| - Pilih kolom Strike pada “STRIKE”.

| - Pilih kolom Dip Angle pada “DIP”,

Il - Pilih kolom Structure Code pada “KODE”,
Atur style simbol dan nkuran simbol.

- Centang dip/plunge as mapinfo labels.

- Seclelah semua sesuai klik QK.

e Nyalakan icon lable tabel “strikc_dip” pada layer control untuk memunculkan labelnya.
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h e Atur tampilan label pada table “strike dip” dengan klik 2 kali pada table tersebut, pilih lable
display, pada lable with pilih “KETERANGAN” untuk memunculkan label jenis simbolnya, klik

OK.

» Nyalakan ikon editable pada tabel “strike_dip”.

o Kemudian kiik 2 kali pada simbol dengan label foliasi & kekar, dan atur séyle-nya sesuai simbol
foha51 & Lekdr

e i Bl

; i - .
i . #oR STREE DEGTRWE DF

"
e PO R e i
S =

| beowmost TEIMNN m W 1TUNOE A |t

e i }———]—mnmuu FITLE
e |

R e T |

» Setelah semua sesuai kembalikan lagi label sesuai kcl,crallgan kemiringan dengan klik 2 kali pada
table “strike dip”, pilih lable display, pada lable with pilih “DIP” untuk memunculkan label
kemiringannya (dip angle). Simpan table (Ctrl+S).

BAGIAN IX
'PEM BUA AN GRID PADA MAPINFO
Grid adalah garis bantu pembacaan koordinat pada peta, dimana akan mempermudah dalam
penentuan posisi ketika menggunakan GPS. Angka koordinat yang digunakan dapat dalam proyeksi
geografis (satuan derajat-menit-detik / satnan derajat-desimal) maupun proyeksi UTM (satuan metric),
S ’. sementdrd interval grid dlscsugikan kebutuhan peugglma

Y 44
(/’“‘

X 2 A B FORA MBS
bt
i
b
{4

e Langkah pertama adalah posisikan objek tepat pada jendela peta, klik ob_;ek “BORDER” kemudian
pada tab discover > map window > zoom to extents of selected object.

e Sectelah posisi objek tepat pada bagian tengah jendela peta kemudian klik pada tab discaver > map
grid, maka akan muncul kolom perintah.

e Atur tampilan grid seperti yang diinginkan, (pada contoh menggunakan interval 1000m / lkm,
posisi koordinat pada bagian kiri dan bawah). Jika telah diatur klik OK.
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u;p__ - _ 2 e i P} MENGATII (NTEMVAL SRID
- :_J—_:- = R TAMPILAK GRID
SOC — - MEMOATUR SKALA SUTPUT
: o m y JUN POGIST
T e e 00 '.' o _' .. '._
) T ey
e Jika telah diklik ok maka akan nmmcul tampilan seperti ini:
F,_g T T 1 §I
| e N . -'
| Semoet 5< En_1_IE_S_Ware_5 I' '
| imrvc e | :
o _“,“_?-r‘ “"“mm ‘ R
- =
O - 1
| E -] % i {
e -
o Kemudian nyalakan editable pada layer “Autogrid”.
e Sctelah itu lakukan CLIPPING pada fable ”Autogrid™.
j G PO, S MW 3 1M 6 Wi -
B = s 8 . nhnn o
j ~ i o :"ﬁ« ;.:}' gy f c
E !_IZED: 5
R 2 o
{1 1)) CEEEEERRlUIN .

q '. o Langkah sclanjutnya adalah “merapikan” koordinat grid, hapus koordinat yang “tidak terpakai”
terlebih dahulu.
* Kemudian pindahkan koordinat yang "terpakai” mendekati garis grid masing-masing.

Loy e L - ]
n_POUL._4_167._3_3005_8. ¥ia DELETE VAt
Sei e e
E SFDPOLENG £y Sl :
o o oS
# A THLA FRINE o ',"a;; % :
| = SALAM FOLENG - ; 2 . L;'
{ i ERIGL POLDNT ’AL—
| = W POET £ FINDASAN
! ALY HGORIWMAT CLTS
e R
| J’ Al . l____ .
| A e -

o ,ui*
LR ¥

| S} ke
i i
INREG

| L5+ ettt 1 1 1§

o Edit masing-masing koordinat (ukuran huruf, perputaran, dil.) dengan cara klik 2 kali pada masing-
masing koordinat, seperti gambar berikut:
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e Atur perputaran setiap koordmat = (pada baglan atas / bawah) menjadi 0° dan koordinat “y”
(pada bagian kanan / kiri) menjadi 90°.

o Afur kembali masing-masing koordinat supaya posisinya tepat pada masing-masing garis grid-nya.

o Setelah sesuai simpan table grid (Ctrl+S) dengan nama “GRID_Nama Mahasiswa_NIM”.

:LAYOU T PADA MAPINFQ

R ;. - Layour adalah prosesi akhir pada mapinfo schingga suatu peta ‘dapat dlsmikan, akan tetap1

' sebelum penyajian terlebih dahulu harus diatur keseragaman ukuran outputnya. Ukuran standar peta
skala 1:25000 adalah kertas A3, maka harus dibuat sefting output kertas menjadi A3, yaitu:

e Klik pada tab option > preferences, maka akan muncul tampilan seperti pada gambar, kemudian

pilih printer dan atur ukuran kertas men) ad1 A3 kemudam Klik OK

fepu—

® b RO& B

D POENS M W ) 16§ We i .
i PpaVasonthE =

i

FLRGATURAH UFAIZATABE
KEHTAS

e Untuk kapling dengan orientasi portrait maka orientasi kertas juga harus portrait, begitu juga untuk
q‘[ _,Q orientasi kapling landscape harus berorientasi kertas landscape.

- ¢ Berikutnya adalah membuat table yang akan kita gunakan sebagai “bingkai”, langkahnya tekan
Cirl+N (new table), kemudian isi field information dengan “frame” kemudian create dengan
nama “FRAME Nama Mahasiswa_NIM" dan save.

e Sclanjutnya pada table “Frame™ buat objek menggunakan rectangle tool sehingga dapat
“membingkai” seluruh fable & grid vang ada di layar.

trndeeat s
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o Kemundar newc ot “Suee’™
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e Setelah diklik save maka zi= = “_mhan. atur resolusi gambar (resolusi
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{DALAM Cm)
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BAGIAN XI
TRANSFER TABLE MAPINFO KE APLIKASI COREL DRAW .
Corel Draw merupakan aplikasi yang sangat membantu dalam proses “modifikasi” peta.
Perbedaan antara Corel Draw dan aplikasi berbasis SIG adalah aplikasi Corel ini tidak dapat
menampilkan informasi geografis yang berupa koordinat, tetapi Corel Draw dapat memroses gambar
dengan lebih baik dan mudah dibandingkan aplikasi berbasis SIG. Karena yang akan ditransfer adalah
jenis gambar vektor Mapinfo (.tab) menjadi jenis gambar vektor Corel Draw (Curve .odr) maka
sebelum diubah aplikasi Mapinfo membutuhkan “fasilitator” berupa file format PDF. Langkah-
langkah exporting file ke format PDF:
e Klik objek “Border” pada layar mapinfo, kemudian pada tab klik Discover > Mup Window > Fir
Map Window to Selected Object. Maka akan ada tampilan seperti ini:

Sl TR SR e S

f——— B
Filc table yang tidak diperlukan untuk dmksport dlllllanlm._ COTCEMETSE DMl WS B 07T

s Klik Print to PDF, akan muncul dialog, Klik OK.

Selanjutnya beri nama file dengan “PETA_Nama Mabssswa NN ok Of

Tangkah selanjuinya adalah membuka aplikasi Cossl Thmw s e (Cai+0) file
“PETA_Nama Mahasiswa_ NIVLpdf” tadi.

]

{‘-g-c oL kv B Pt

e Setiap file table yang dieksport dari Mapmio secars otomans skan dikonversi menjadi layer pada
Corel Draw, selanjutnya tinggal mengatur skala sa=har pads Corel Draw yang sesuai dengan skala
sebenarnya pada “kolom ukuran gambar™ (==sal pads pera skala 1:25000 dengan luasan 6X9
Km maka ukuran gambar adalah 2403360 M= siz= den uhoran menyesuaikan. Seve dengan
nama “PETA_Nama Mahasiswa NIM™.

e Sclanjutnya  pada Corel Draw pez depa diolzh sesnai kebutuhan.
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